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This guide provides information for Authorized Support Contacts (ASC) on how to best utilize SAP Concur
Support, including the following topics:
•

ASC Management

•

Request Support

•

Escalation Process

•

Priority 1 Incidents

•

Case Management through the SAP Concur Support Portal

Note: This guide is updated annually.
AUTHORIZED SUPPORT CONTACT MANAGEMENT
During Implementation, SAP Concur assigns the required two and up to five company-designated Authorized
Support Contacts (ASC) access to the SAP Concur Support Portal, chat, and phone support. Thereafter,
additional ASCs (maximum of five) will be managed by your company’s Administrators. To activate the access,
the ASC clicks the Contact Support link.
Standard Edition
ASC Permission – User Permissions
This permission grants access to the Support Portal. Administrators manage the ASC access by following the
steps below:
1. From SAP Concur, navigate to Administration > Expense or Invoice or Expense & Invoice Settings >
User Accounts.
2. In the Search box, enter the user’s data and click the magnifying glass icon.
3. To open, double click the user’s name.
4. Scroll to the User Permissions section.
5. Select the following permission based on your product:
a. Can Administer (for Travel only or Expense only customers)
b. Is Invoice Admin (for Invoice only customers)
c.

Travel & Expense Administrator (for Travel and Expense customers)

6. Click Save.
Professional Edition
There are two options to manage access for ASCs. Travel & Expense customers can utilize both options.
1. ASC Permission through User Administration (Best Practice)
2. ASC Permission through Permission Administrator
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1. ASC Permission – User Administration

2. ASC Permission – Permission Administrator

Available for customers with Expense or Invoice.
Administrators manage the ASC permission by following
the steps below:

Available for customers with Travel.
Administrators manage the ASC permission by following the
steps below:

1.

From SAP Concur, navigate to Administration >
Company > Company Admin > User
Administration.

1.

From SAP Concur, navigate to Administration >
Company > Company Admin > Permission
Administrator.

2.

In the Search Text box, enter the user’s data that
corresponds with the selection in the Search What
drop-down and click Search.

2.

Click the Travel tab (if applicable).

3.

Select Modify Permissions by: Permissions.

3.

To open, click the user’s Last / First name link.

4.

Select the Permission Name: Authorized Support
Contact.

4.

Select the Authorized Support Contact box.

5.

5.

Click Save.

Find and select the user to update and click Add or
Remove.

6.

Click Save.

SAP CONCUR SUPPORT PORTAL
The SAP Concur Support Portal provides resources and self-service offerings. SAP Concur Support provides
assistance for up to five company-designated ASCs. Once the ASC permission has been assigned, the Contact
Support link will automatically appear within SAP Concur for convenient access to the SAP Concur Support
Portal via Single Sign-On (SSO). To activate this access, click Help > Contact Support.

Alternate Contact Support Link Locations and Trusted Site
The Contact Support link may appear at the bottom of the page or as Support next to the Help tab. To allow
access, ensure pop-up blocker is disabled and add one of the following as a trusted site in your browser settings:
•

Standard Edition – https://concur.secure.force.com/CteStandard/

•

Professional Edition – https://concur.secure.force.com/CteSupport/
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SAP Concur Support Portal – At A Glance

1. My Profile | Close (Log out): Easily update profile information and log out (Close).
2. Menu Tabs: Access to the most commonly used features.
3. Ask us anything Search Bar: Quick access to Knowledge Base answers, cases, Improvement Requests,
Training, Technical Publications (e.g. User Guides), and SAP Community.
4. Information Center: View important notices from Support, Security, and Operations (maintenance) and optin to receive these notices by e-mail.
5. Create and View Cases: A designated area for prompt and convenient access to cases.
6. Knowledge Base: Accessible from different SAP Concur Support Portal pages to easily find answers.
7. Improvement Requests: Submit, view, and vote on improvements.
8. Chat with Support: Receive assistance through chat for quick questions.
9. Call Support: Link to access the Global Support phone numbers.
10. From the Community: A place for customers to share information with each other.
11. Quick Link Menu Bar: Complete visibility of the top Menu Tabs and their drop-down menu selections.
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My Profile Options and Preferences
When transferring to the SAP Concur Support Portal for the first time, the User Information Confirmation box will
display prompting to create your My Profile. Complete the required fields, options, preferences, and review first
name, last name, and e-mail address. If name or e-mail needs modification, contact your Concur Administrator
as changes must be made in your Concur profile.
Language Option
In addition to English, the SAP Concur Support Portal offers seven localization options for ASCs: Chinese
(Simplified), French, German, Japanese, Korean, Portuguese (Brazilian), and Spanish. When an ASC chooses a
language option from the Select Your Language drop-down menu, the static values on the SAP Concur Support
Portal pages will be translated. This translation includes headers, footers, and content in the drop-down for case
topic and case type values.
Note: For customers who have purchased the User Support Desk (USD) service, users can choose between six
localization options in addition to English upon initial login to the USD Portal: Chinese (Simplified), French,
German, Japanese, Portuguese (Brazilian), and Spanish. Language options can be changed at any time within
the user’s USD Portal profile.
Preferences
Authorized Support Contacts can manage and update Preferences to opt in (or out) of the following offerings:
•

Service Alerts – Receive e-mails for any incidents managed outside of Concur Open, our System Status
Dashboard, or extenuating notifications other than incident management.

•

Language Support – Accept support in English when high demand for specific language support causes
a delay in cases being addressed.

•

Information Center Notices – Receive important Information Center Notice e-mails from Support,
Security, and Operations.

•

Case Calls – Opt out to receive calls regarding cases.

For additional SAP Concur Support Portal information, please reference the Documentation and e-Learning
Course section.
REQUEST SUPPORT
Authorized Support Contacts (ASC) can contact SAP Concur Support for assistance by creating a case in the
SAP Concur Support Portal, chat, or phone. To report an issue, ask a question, or make a request, the preferred
method is to create a case. Regardless of the complexity of the issue or request, submitting a case provides the
most efficient results by allowing detailed information and relevant documents to be included.
For detailed information, refer to the Support Policy for SAP Cloud Services.
Customer Responsibility
ASCs are encouraged to review the Knowledge Base in the SAP Concur Support Portal for a possible solution
prior to contacting SAP Concur Support for assistance. If you are experiencing a performance issue outside of
scheduled maintenance, check Concur Open or your inbox if subscribed to Personalized Concur Open
Notifications.
For SAP Concur Support to resolve an issue, the steps to reproduce must be provided. When possible, copy and
paste the information from your SAP Concur solution into the case especially for record locator, report IDs, or job
numbers to ensure accuracy.
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USD Case Handling
For customers who have purchased the User Support Desk (USD) service, when SAP Concur Support requires
ASC involvement to resolve a user issue, the case will be assigned to an ASC. The ASC will be responsible for
the following:
•
•
•
•
•

Acting as the main contact
Working hand in hand with SAP Concur Support
Collecting information from user
Authorizing testing
Approving or conducting configuration changes

Customer Response Levels
All cases will automatically default to a Priority 3 (P3) and once SAP Concur Support reviews the case, a priority
is assigned. The priorities are described in the Customer Response Levels section of the Support Policy for SAP
Cloud Services and determines the maximum length of time for initial response, ongoing communications, and
targeted resolutions.
Note: For resolutions that are dependent upon third-party vendors, the ongoing communication levels are not
applicable.
Mission Critical Support
Based on assigned priority, cases will be worked as listed below:
•

24x7 Mission Critical Support for P1 and P2 issues (English only)

•

Non-Mission Critical Support for P3 and P4 issues during business hours (English only) – Monday to
Friday 8 am to 6 pm (Local Time Zone), excluding local holidays

24/7 Chat and Phone Support
Chat and phone support are most effective for basic questions that can be easily answered. ASCs may be asked
to provide their name, company name, SAP Concur solution, and to verify the e-mail address associated with the
account. The SAP Concur Support representative will create a case to provide a transcript of the conversation
for our records. Should more advanced support be required, the case will be transferred to the group with the
appropriate level of expertise.
Chat with Support: On the SAP Concur Support Portal home page, click Chat with Support and
based on the assistance needed, select one of the following four options: Expense, Travel,
Invoice, or Concur Request. Once selected, a dialog box will display for an SAP Concur Support
representative to join the Chat.

Phone Support: If all representatives are engaged with other customers, a callback feature will
be offered to reserve your place in the queue by entering a phone number.

Co-browse: SAP Concur Support also offers a Co-browse feature which is a secured screenshare application providing view-only access to your SAP Concur solution. This feature is
available to Authorized Support Contacts located under the Help menu.

Note: The Global Support Phone Numbers can also be found on the SAP Concur Support Portal home page >
Call Support > View global phone numbers.
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Global Support Phone Numbers

Note: Users calling the Global Support phone numbers will be advised to contact your company Administrator or
redirected to the User Support Desk (USD) if your company has purchased the USD service. For companies that
have purchased the USD service, the Contact Support link is visible to all users to search the Knowledge Base,
chat with Support, or create a case. The Global USD phone numbers can be found on the USD Portal (USD
Home > Support Hotline > View global phone numbers) and in the Knowledge Base.
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SCHEDULED MAINTENANCE
ASCs will be notified in advance when scheduled maintenance is expected to render a service unavailable for 60
minutes or more. A notice will be posted to the Information Center on the SAP Concur Support Portal home page
and ASCs may select Opt In to receive Information Center Notices by e-mail under My Profile. Additionally, a
Service Notification will be posted on Personalized Concur Open (PCO).
Note: If users experience a performance issue during maintenance, it is not necessary to contact SAP Concur
Support.

ESCALATION PROCESS
Cases
In the unlikely event a response is not received within the Customer Response Levels, please ask for an update
in the Case Comments section. If the case needs to be escalated, click the Escalate button within the case and
an escalation notice will be sent to the assigned team. A red up arrow next to the Case Number denotes
escalated cases.
This process applies regardless of whether the case was initially submitted on the SAP Concur Support Portal,
via chat, or through phone support.
Product and Technology
SAP Concur Support may need to escalate the case to Product and Technology (f/n/a R&D) for investigation and
prioritization. In these instances, the assigned representative remains responsible for providing case updates
until resolution.
Below are the possible updates on the outcome of the investigation:
•

We have investigated and fixed this issue.

•

We have investigated this issue and have scheduled it to be fixed in an upcoming sprint.

•

We have investigated this issue but, due to effort/complexity or scheduling constraints, we have
rescheduled it for additional investigation in an upcoming sprint.

•

We have investigated this issue and determined that we will be unable to prioritize it for resolution at this
time. We will continue to monitor this issue going forward for consideration in future maintenance or
feature enhancements.

P1 AND TRAVEL P2 INCIDENTS
If a P1 or Travel P2 incident is reflected within the resources below, it is not necessary to contact SAP Concur
Support. To receive incident updates by e-mail, refer to Subscribe to Notifications.
Concur Open
To view P1 Incidents, Concur Open, Service Status Dashboard, displays availability status 24/7 for SAP Concur
solutions. Service status can be viewed by day for the most recent 20 days.
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Service Status Dashboard Legend
Service availability status is indicated by one of the icons below. For a definition, hover your mouse over each
icon in the legend located at the bottom of the Service Status Dashboard.
Normal – Service is 100% up and operating normally.
Disruption – Service is unavailable or unusable for all users.
Degradation – Service is unavailable or unusable for many users.

Message Types
In the event of a P1 incident, a series of messages will provide information as SAP Concur works to resolve the
issue. The table below outlines the types of messages found by clicking the icon associated with a service not
operating normally.

Message Type

Message Description

Issue Identified

Marks the start of the incident and provides preliminary information regarding the
potential user impact.

Issue Status Update

Confirms the accuracy of the Issue Identified message and describes the service
impact. Updates are sent approximately every hour and provide more details.

Issue Resolved

Marks the end of an incident and indicates the service has returned to normal.

Issue Identified and
Resolved

Marks the end of an incident and indicates the service has returned to normal.

Root Cause Analysis (PCO
only)

Provides detailed information about the cause of the incident, resolution, and
corrective actions taken to ensure prevention of future occurrences.
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Personalized Concur Open
P1 Incidents
Authorized Support Contacts and users can log in to a personalized view of the Concur Open Service Status
Dashboard displaying availability status 24/7 for the most recent 20 days for purchased services. Additionally, a
history for the past two years is listed under View Service History.
Note: Refer to the Service Status Dashboard Legend and Message Types for detailed information.
Travel P2 Incidents
Travel P2 incidents can be viewed under the Active P2 tab and a history is available by clicking View Service
History.
Log in to Personalized Concur Open
To access Personalized Concur Open, log in using your existing SAP Concur credentials or e-mail address if
using Single Sign-On (SSO) by following the steps below:
1. Navigate to Concur Open.
2. Click Log in to Personalized Concur Open.
3. Select Username.

Or

a) Enter SAP Concur username and click
Continue.
b) Enter password and click Sign In.

Select Send a link to my e-mail
(required for SSO users)
a) Enter the e-mail address and click Continue.
b) From your e-mail, click
Sign in with SAP Concur.

Note:
•

If using SSO, the e-mail address must be unique and not a shared e-mail within your organization.

•

The one-time SSO link is active for one hour after being generated.

•

Once logged in, access remains active for 30 days.

Subscribe to Notifications
The Personalized Concur Open subscription feature allows customers to sign up and receive real-time e-mail or
RSS notifications about service issues that are specific to your company. E-mails are sent from
ConcurOpenUpdates@sap.com for all subscribed preferences.
To subscribe to notifications through e-mail, follow the steps below:
1. Once logged into Personalized Concur Open, click Subscribe to Notifications.
2. On the Set Notification Preferences page, enter your e-mail address and select your preferences.
3. Click Subscribe.
4. Check your e-mail for a link to verify your subscription.
5. Click Verify Subscription to confirm.
Note:
•

When updating your e-mail address for notifications, verification will be sent to confirm you are the
owner.
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•

Only one subscription e-mail address will be allowed and can be changed at any time.

•

Click RSS to display the XML file to be added to your RSS reader. The RSS notifications will include all
Personalized Concur Open notifications.

SERVICE ALERT E-MAILS
Service Alerts are e-mails for incidents managed outside of Concur Open or extenuating notifications other than
incident management. To receive Service Alerts from concursupport-servicealerts@concur.com, update the My
Profile page in the SAP Concur Support Portal by following the steps provided below:
1. From SAP Concur, click Contact Support.
2. Click My Profile.
3. Check the Opt In to receive Service Alert e-mails box and click Save.
Note: To stop receiving Service Alerts, uncheck the Opt In to receive Service Alert e-mails box and click Save.
CASE MANAGEMENT
On the SAP Concur Support Portal, cases can be created, viewed, updated, and downloaded.
Creating a Case
1. From SAP Concur, click Contact Support to access the SAP Concur Support Portal.
2. From the home page, click Create a Case.
3. Enter details in the Case Description field including steps to reproduce the issue, unique identifiers, date
and time, impacted users, or other pertinent details related to the case.
4. Enter a brief description of the case in the Subject field.
Based on the subject entered, any relevant Knowledge Base articles or Concur Training resources such
as user guides, videos, release notes, and other documents will be displayed in the Suggested Articles
section.
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5. Within the Suggested Articles section, click the appropriate link to display the article or resource.
•

To review a specific article, click the article link and a new window will open.
o

If the article answers the question, click Yes – Take me to the Knowledge Base or
navigate to another tab on the SAP Concur Support Portal.

o

If no relevant articles display, click Continue Creating a Case.

Note: Within the Knowledge Base, articles can be viewed in additional languages by clicking the
Language drop-down and selecting the desired language.
6. Select the most appropriate Topic and Case Type from the drop-down lists.
7. Select the most appropriate Urgency (Customer Assessment) from the drop-down list. The options
include:
•

1 – Very High (Core service is completely down)

•

2 – High (Business processes seriously disrupted)

•

3 – Medium (Business processes affected)

•

4 – Low (Little or no effect on business processes)

8. Cases automatically default to P3 – Medium. Refer to the Customer Response Level section for
additional information.
9. Select the appropriate Case Region from the drop-down list. The options include:
•

APA

•

EMEA

•

LATAM

•

North America

10. Enter the Site/URL/Acct. # if applicable.
11. If the preference is to have an SAP Concur Support representative call before working the case, select
the Call Me box. Please ensure the correct phone number is listed in My Profile.
12. To authorize SAP Concur to troubleshoot the case within your production site, select the Concur may
test in my production site box.
13. If Service Administration, Service Assistant, Concur Advanced Care, and Concur Select Care has been
purchased, check the Expertise & Care box to route the case to the applicable queue.
14. Select the appropriate reason for your case from the Assistance Needed with drop-down list to help
engage the best resource.
15. Enter up to eight additional e-mail addresses in the CC E-mail fields to include others on updates from
SAP Concur Support.
Note: Cases can be updated through e-mail, however, updates cannot be viewed from the SAP Concur
Support Portal.
16. Click Submit & Add Attachments to attach any documentation that can assist SAP Concur Support in the
case resolution. Complete the three steps to attach a file. Each file is limited to 25 MB.
Note: For security purposes, attachments are not allowed on case updates through e-mail.
17. Click Submit and a case number will automatically be assigned.
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Note: For data files, the preferred method is to upload the import or export job file to a
company’s File Transfer Protocol (FTP) site without encryption. This method allows SAP
Concur Support to access and view files in a secure manner. Additionally, please do not
attach files with sensitive data such as complete credit card or social security numbers.

Viewing a Case
1. From SAP Concur, click Contact Support to access the SAP Concur Support Portal.
2. From the home page, click the View Cases box.
3. From the View drop-down list, choose from one of the following options:
•

1 – All Open Admin Cases

•

2 – All Closed Admin Cases

•

3 - *All Open End User Cases

•

4 - *All Closed End User Cases

•

5 – My Cases

•

6 – Recently Viewed Cases

*These selections are only available if the
User Support Desk service has been purchased.
If purchased, please do not edit user cases as
they are in Support’s hands.

4. To sort cases by ascending or descending order, click on a specific column heading.
5. To view one case at a time, click the Case Number or Subject link.
6. To update a case, click Add Comment in the Case Comments section.
7. To search the Knowledge Base, click Find Articles.
8. To add an attachment, click Attach File and complete the three steps. Each file is limited to 25 MB.
9. To close a case, click Close Case, select Close under Status, and click Submit.
10. To print a case, click the Printable View link.
Note: Cases can be updated through e-mail; however, for security purposes, attachments are not allowed.
Additionally, e-mail updates cannot be viewed from the SAP Concur Support Portal.
Pending Customer Status
If SAP Concur Support requires additional information to resolve a case, the status will change to Pending
Customer. The Case Comments section will specify what is needed in order to proceed. No progress can be
made until the case is updated with the requested information. Should customers choose not to respond, the
case will be automatically closed in 30 days. A case can be re-opened within seven days of closure; however,
after that time, a new case must be created.
Downloading a Case Report
1. From SAP Concur, click Contact Support to access the SAP Concur Support Portal.
2. From the home page, click the Support tab at the top of the menu bar.
3. Click Download Case Report.
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4. Select the appropriate Report Criteria:
•

Report Type: My Organization’s Cases, My Cases, or End User Cases

•

Case Status

•

Cases Created Between and/or Cases Closed Between

•

The number of records per page

•

Select Excl. Subsidiary Cases to exclude child company cases from a parent company to help
minimize privacy concerns.

5. Click Execute Report. Executing a report runs the query to pull the requested data which is displayed on
the screen.
6. Click Download Report.
•

If there are more than 250 records, click Report Files. When the report is available for download,
the Request Status will change from Requested to Completed and the
Download Report link appears.
Note: An e-mail notification will be sent when the report is available to download.

•

Downloading the report transfers the following data into an Excel file: Subject, Case #, Date
Created, Reported By, Date of Last Comment, Status, Site/URL/Acct. #, and Date Closed.

Note: The user and Audit Cases report types are only available to download if the User Support Desk or Audit
services have been purchased.
Closed Case Survey
After a case has been closed, an e-mail with a link to the Closed Case survey will be sent. This survey allows
ASCs an opportunity to provide feedback on the level of satisfaction with the knowledge, communication, and
timeliness of the resolution from SAP Concur Support.
DOCUMENTATION AND E-LEARNING COURSE
The resources listed below can be found in the SAP Concur Training Library.
•

Case Responsibility Assignment RACI Matrix

•

Getting the Most from SAP Concur Support e-Learning Course
o

The e-Learning course can also be accessed by following this path on the
SAP Concur Support Portal: Resources > Webinars > Concur Support
Training.

•

Getting the Most from SAP Concur Support Quick Reference Guide

•

Getting the Most from User Support Desk Quick Reference Guide

•

How to Navigate the SAP Concur Support Portal

•

Online Billing Portal Guide
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